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INTRODUCTION

What This Manual Is

The National Center for Health Statistics (NCHS) began developing the Mortality Medical
Data System in 1967 to automate the entry, classification, and retrieval of cause-of-death
information reported on death certificates. Mortality medical data is processed through
four basic programs: Super-MICAR, MICAR , ACME , and TRANSAX .1 2 3

Super-MICAR Automates the MICAR data entry process (see Part 2g of the
Vital Statistics Instruction Manual (VSIM) series).

MICAR Automates the multiple cause coding rules (see Parts 2b and 2e
of the VSIM series).

ACME Automates the underlying cause-of-death coding rules.  The
input to ACME is the multiple cause-of-death codes (ICD)
assigned to each entity (e.g., disease, condition, accident, or
injury) listed on cause-of-death certifications, preserving the
location and order as reported by the certifier. ACME then
applies World Health Organization (WHO) rules to the ICD
codes and selects an underlying cause of death (see Parts 2a and
2c of the VSIM series).

TRANSAX Converts the ACME output data into fixed format and translates
the data into a more desirable statistical form using the linkage
provisions of the ICD.  TRANSAX creates the data necessary
for person-based tabulations by translating the axis of
classification from an entity to a record basis.

In 1990, NCHS began to convert the processing of mortality medical data from a
mainframe computer platform to the PC platform. PC-ACME/TRANSAX is a PC version
of the ACME software and the TRANSAX software. PC-ACME/TRANSAX includes a
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MICAR rejects editor which also permits entry of ACME input records as well as an
ACME rejects editor which permits interactive review of the messages generated by
ACME.

Who This Manual Is For

This manual is intended for anyone who will be using PC-ACME/TRANSAX. It is
organized on the assumption that the user has little familiarity with PC-
ACME/TRANSAX. The user must be knowledgeable of NCHS multiple cause-of-death
coding rules. The user's primary duty is to use PC-ACME/TRANSAX to process multiple
cause codes and, where necessary, edit the codes so that there are no errors in the
processing. Therefore, the subjects in this manual are arranged so that the user can start
processing data after the system has been installed.

Changes in 1995

1. The maximum record limit of 2,000 records in an ACME input file has been
removed. The ACME input file size is limited only by the available free space on
the hard drive. A window will be displayed when ACME is started giving the user
an approximation of how many records may be stored on the drive.

2. PC-ACME/TRANSAX now has the ability to print the MICAR rejects. This option
is under the Print/Reports menu.

3. ACME Tables:

Causal Relationship Table:  (Table C in NCHS Instruction Manual, Part 2c, 1995)
This table has been modified to show that "Positive serological or viral culture
findings for human immunodeficiency virus" (798.5) has the same causal
relationship as "Human Immunodeficiency Virus (HIV) Infection" (044.0 - 044.9)

Modification Table (Table D in NCHS Instruction Manual, Part 2c, 1995). This
table has been modified to show that "Positive serological or viral culture findings
for human immunodeficiency virus" (798.5) have the same linkage relationship as
"Human immunodeficiency virus infection, unspecified" (044.9)

4. TRANSAX Tables. The tables used by the TRANSAX software have been
modified to include all modifications made for the ACME system
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5. Conversion to database files. ACME/TRANSAX now uses a database file for
processing. It still retains the ability to export TRANSAX input and output files in
an ASCII format (see EXPORT FUNCTIONS in the PC-ACME/TRANSAX
System Manager's Manual).

6. Added ability to import ASCII files and convert them to database (.DBF) files (see
Importing Files, pg. 11).
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OVERVIEW

Basic Steps

Below is a general procedure giving the order to use PC-ACME/TRANSAX's Menu
Options and Functions. It may be necessary at times to alter the overall process. In these
cases, contact the supervisor. A flow chart to illustrate the overall process has been
provided at the end of this section.

1. Import MICAR data files. Import data files to the <ACME\DATA> directory.
Alternatively, the user can Create a New Input File. The input file is the file
containing the certificates data.  The user will need to select an input file every
time PC-ACME/TRANSAX is started or when a new batch of data is being used.
(Importing Files, pg. 11).

2. Create a new data file or open a data file for processing. (Creating a New Input
File, pg. 14; Opening an Input File, pg. 15).

3. Micar rejects may be printed out before coding (see VIEWING MICAR
REJECTS, pg. 17).

4. Edit MICAR rejects. If the selected file has any MICAR rejects, these rejects will
need to be edited before any ACME or TRANSAX processing is performed.
(EDITING MICAR REJECTS, pg. 19).

5. Edit and correct the ACME Input File. If a new file has been created, certificates
will need to be added to it (the maximum number of records is determined by the
amount of free space on the hard drive). Also, editing may need to be performed on
existing certificates. (EDITING AN ACME INPUT FILE, pg. 22).

6. Check the ACME input file sequence. A sequence check will tell the user if there
are any certificates missing from the batch. This check assumes that all of the
certificate numbers are sequential. (RUNNING A SEQUENCE CHECK, pg. 28).

7. Process An ACME File. This is the processing stage of ACME, where the input file
is processed and an underlying cause of death is determined. (PROCESSING AN
ACME FILE, pg. 30).
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8. View ACME stats. The results of the processing need to be viewed to determine if
any records have been rejected. (VIEWING ACME STATS, pg. 31).

9. Edit ACME rejects. If ACME detects any errors, the certificates will need to be
edited. In this case, steps 4-7 will need to be repeated. (EDITING ACME
REJECTS, pg. 33).

10. Re-process ACME Rejects. If any ACME rejects were edited, they will need to be
re-processed. (PROCESSING AN ACME FILE, pg. 30).

11. Run TRANSAX. TRANSAX processing is the second part of
PC-ACME/TRANSAX. TRANSAX will process the ACME output, performing
manipulations of the data to generate record-axis data. (PROCESSING A
TRANSAX FILE, pg. 38).

12. View TRANSAX statistics. The final step in processing a batch of data is to
examine the TRANSAX statistics and look for any mistakes or discrepancies.
(VIEWING TRANSAX STATS, pg. 39).

13. Send Files to NCHS. The processed data is now ready to be sent to another
software package or sent to another location for further processing. This is a duty
performed by the System Manager. The functions needed to do this are describe in
the PC-ACME/TRANSAX System Manager's Manual under SENDING FILES TO
NCHS. 

14. Create backups. Backups of the processed data from an open file should be made
to prevent accidental loss of data. All of the data and the associated files will be
backed up. NOTE: Backups should be made daily! Backups can be made with
incomplete files. (CREATING BACKUPS, pg. 41).

15. End session. At this point, the data has been processed and the user can either quit
PC-ACME/TRANSAX or begin processing a new batch. To process a new batch,
simply start the process described above over again. (ENDING A SESSION
WITH PC-ACME/TRANSAX, pg. 45).
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THE MENU SYSTEM

Quick List of Menu Options

TABLE 1:        
Key Combination               Menu Option Accessed      

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-R} Run Menu Option

{ALT-P} Print/Reports Menu Option

{ALT-V} View-Info Menu Option

{ALT-H} Help Menu Option

Table 2 Hot Keys and Functions

File
{SHIFT-F8} Import ACME Input Files
{F2} Open Input File
{ALT-F2} Create New Input File
{ALT-F4} Close Input File
{SHIFT-F7} Send Files To NCHS
{ALT-F7} Backup All Files
{ALT-F8} Restore From Backup
{ALT-D} Set Data Path
{ALT-T} Set Table Path

Export TRANSAX Input File to ASCII
Export TRANSAX Output File to ASCII

{ALT-X} Exit

Edit
{ALT-M} Correct MICAR Rejects
{F9} Correct ACME Reject Records
{ALT-I} Edit ACME Input File
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Run
{F6} Process ACME
{F7} Process ACME Rejects
{F8} Run TRANSAX

Print/Reports
{ALT-F3} Sequence Check

Show/Print Micar Rejects

View-info
ACME Stats
TRANSAX Stats
Browse Input File
Configuration

Help
{F1} Display Help Text
{ALT-F1} About ACME

Using the ACME/TRANSAX Menu System

PC-ACME/TRANSAX Functions are available through a drop-down menu system. The
menu system allows the user to select Functions to perform and to move from task to task
quickly and easily. Unlike the menu lists available through other types of software, PC-
ACME/TRANSAX uses a menu system that allows options to be selected from the menu
even when another function is active. This allows users to select Functions more quickly,
without having to exit their way 'back up the tree' before they can select another function.

There are two ways to access the menu: 

ALT-X: Simultaneously pressing the {ALT} key and the highlighted letter key of a
main menu item will display the drop-down menu for that item. (The Alt
keys for each menu option are listed in Table 1.) Then use the up and down
arrow keys to highlight an item on the menu. Press {ENTER} to select the
option. Use the left and right arrow keys to open submenus for other main
menu options. Pressing {ESC} from a dropped-down menu closes the
menu. Pressing {ESC} from the main menu will exit PC-
ACME/TRANSAX.

HotKey: Many of the Functions in the menus have an associated hotkey. The hotkey
assignments are shown on the drop-down menus and are listed in Table 2.
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PC-ACME/TRANSAX - TEST01.DBF
File     Edit     Run     Print/Reports     View-info       Help

                     +)))))))))))))))))))))))))))))))))))),
                     * Sequence Check              Alt-F3 *
                     * Show/Print Micar Rejects           *
                     .))))))))))))))))))))))))))))))))))))-

                          F1-Help                         4 27pm

Figure 1:  The Print/Reports submenu.

Pressing a hotkey will immediately access the associated function. (For
example, pressing {F2} will select the Open Input File Function.) Hotkeys
are the fastest, easiest way to move around PC-ACME/TRANSAX. As
users become familiar with PC-ACME/TRANSAX, they will find the
hotkeys easier to use. 

To select a Function from a drop-down menu, either use the up and down arrow keys to
highlight an option or press the option's selection letter. The selection letter is displayed in
red (on color monitors) or highlighted (on monochrome monitors). Pressing the selection
letter will move the highlight bar to the selected option.

Figure 1 gives an example of the Print/Reports Menu Option and its Functions.

Not all Functions are available at all times. In order to prevent users from selecting
Functions that should not be accessed during a particular process, the menu system will
make certain Functions available (active) or unavailable (inactive). On color monitors, the
active options are shown in black while inactive options are shown in gray. On
monochrome monitors, inactive options do not have a highlighted selection letter. When
an option is inactive, it cannot be selected (the highlight bar will skip over that item and
it's hotkey will not function).
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PC-ACME/TRANSAX - TEST01.DBF
File     Edit     Run     Print/Reports      View-info       Help

                           F1-Help                         4 27pm

Figure 2: The main screen with the Menu Bar and Menu Options.

GETTING STARTED

Starting ACME/TRANSAX

PC-ACME/TRANSAX allows the user to edit certificate data and correct errors. This
manual deals with correcting and processing an ACME input file and then processing the
ACME output using TRANSAX. To start PC-ACME/TRANSAX, do the following:

1. Make sure that the DOS prompt is currently in the <ACME> directory (Example:
C:\ACME or F:\SYSTEM\ACME).

A. To make sure the current directory is the <ACME> directory, type CD and
press {ENTER}. The current directory name will be displayed on the screen.

B. To change the current directory to the <ACME> directory, contact the System
Manager.

2. To start PC-ACME/TRANSAX, type ACME and press {ENTER}.

3. A window will be displayed telling the user the maximum number of records that
can be processed with the existing hard drive space. Press {ENTER} to continue,
or press {N} to exit PC-ACME/TRANSAX and return to the DOS prompt.

4. The main screen (Figure 2) will be displayed. Refer to the Accessing The Menu
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Bar (pg. 7) section of this manual for more details on the main screen and the
Menu Bar.

When the main screen appears, PC-ACME/TRANSAX is ready to begin.

About the Main Screen

The main screen of PC-ACME/TRANSAX has several useful features:

1. At the top of the main screen will be the title. This line will also show the filename
of any open certificate file (see).

2. The second line of the screen holds the menu bar. The menu bar has several words
on it, called Menu Options. Each Menu Option has several Functions that can be
used. See Using the ACME/TRANSAX Menu System (pg. 8) for more details.

3. At the bottom of the screen is a bar displaying some useful information:

A. In the center, a not appears about the {F1} key. The {F1} key will display PC-
ACME/TRANSAX's online Help feature. This will give brief instructions about
whatever part of PC-ACME/TRANSAX is currently being used.

B. In the lower right corner is a clock showing the current time.

Importing Files

The following actions must have already been performed before files can be imported:

All open files must be closed (CLOSING A FILE, pg. 44).

ASCII files may need to be imported into PC-ACME/TRANSAX after they've been
processed by MICAR100/200. These data files will usually be on a floppy disk or in
another directory on the computer. Importing copies the selected files into the
<ACME\DATA> directory.

1. Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Import ACME Input Files
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PC-ACME/TRANSAX - TEST01.DBF
File     Edit     Run     Print/Reports      View-info       Help

6444444444444444444444444444444444444444444444444447
5         Select ACME input file to import         5
K))))))))))))))))))))))))))))))))))))))))))))))))))M
5+) Directory)))))))))))))))))))))))))))))))))))),   5
5* C:\                                           *  5
5.))))))))))))))))))))))))))))))))))))))))))))))-   5
5  Files          Directories                      5
5                 <ACME>         +) Filter)))))),    5
5                 <DOS>          **.DBF        *   5
5                                .)))))))))))))-    5
5                                                  5
5                                +) File)))))))),    5
5                                *             *   5
5                                .)))))))))))))-    5
5                                                  5
5                                                  5
5                 Drives               OK      (   5
5                 A:              &&&&&&&&&&&&&&    5
5                 B:                 CANCEL    (   5
5                 C:              &&&&&&&&&&&&&&    5
9444444444444444444444444444444444444444444444444448

                         F1-Help                           5 14pm

Figure 3:  A file selection window.

Function and press {ENTER}.

3. A file selection window (see Figure 3) will be displayed.

4. The following fields will be displayed on the file selection window:

Directory
(Pick List of Files)
(Pick List of Directories)
(Pick List of Drives)
Filter
File
OK
CANCEL

5. To select a new disk drive to import files from, do the following:

A. Use the {TAB} key to put the cursor in the Pick List of Drives.
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B. Use the up and down arrow keys to highlight the desired drive.

C. Press {ENTER}. The highlighted drive will be selected. Both the Pick List of
Files and the Pick List of Directories will be updated for the new drive.

6. To select a new directory to import files from, do the following:

A. Use the {TAB} key to put the cursor in the Pick List of Directories.

B. Use the up and down arrow keys to highlight the desired directory. The parent
directory (the directory containing the current directory) is listed as "<..>".

C. Press {ENTER}. The highlighted directory will be selected. The Pick List of
Files will be updated for the new directory.

7. To select a file from the Pick List of Files for importing, do the following. NOTE:
If the Pick List is empty, it cannot be accessed. In this case, select a new drive or a
new directory.

A. Use the {TAB} key to put the cursor in the Pick List of Files.

B. Use the up and down arrow keys to highlight the desired filename.

C. Press {ENTER}. The highlighted file will be selected. If a file with the same
name already exists in the <ACME/DATA> directory, a message window will
be displayed. To overwrite the file in the <ACME/DATA> directory, press
{ENTER}. To cancel the import and return to the file selection window, press
{C}.

8. Once a valid file has been selected it will be imported into the <ACME\DATA>
directory. A progress bar (see Figure 4) will be displayed showing what
percentage of the file has been imported. When the import is complete, a message
will be displayed. Press {ENTER}. The main screen will be re-displayed.
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+))))))))))))))))))))))))))))))))))))))))))))))))))))))))))),
*           Processing  ACME Batch TEST1.DBF ...            *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))1
*                       Record 66                           *
*                                                           *
*                            37%                            *
* $$$$$$$$$$$$$$$$$$$$"""""""""""""""""""""""""""""""""""""  *
* 0          Estimated time remaining: 00:00:05         100 *
.))))))))))))))))))1  Press Esc to stop /))))))))))))))))))))-

Figure 4:  A bar graph showing the progress of file processing.

9. Repeat steps 1-8 above as often as necessary to import the data files. When all of
the desired files have been imported, press the {ESC} key to re-display the main
screen.

10. The last file to be imported will be open for processing.

Creating a New Input File

A new ACME input file can be created by following the steps below. Remember, the
maximum number of records in a file is determined by the amount of free space on the
hard drive.

1. From the main screen, Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Create New Input File Function
and press {ENTER}.
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+))))))))))))))))))))))))))))))),
*     Create New Input File     *
/)))))))))))))))))))))))))))))))1
* Enter file name:         .DBF *
.)))))))))))))))))))))))))))))))-

Figure 5:  Type in a new filename to create a new input file.

3. A window will be displayed asking for a filename (Figure 5). Type in a valid
filename of up to 8 characters (Example: TEST1) and press {ENTER}. DO NOT
type in an extension. The extension will be automatically added by PC-
ACME/TRANSAX.

The filename is determined by the user. The name should be meaningful to the
person creating the file and to other users of the same file.  

For example, NCHS uses [ssddnnn] for filenames when processing MICAR data
from states, where:

ss - 2 character state abbreviation (see APPENDIX A, pg. 46, for a
list).

dd - 2 digit data year.

nnn - 2 or 3 digit number indicating the shipment or lot number. This
number is unique for each file processed.

Thus: IN93076 has "IN" as the 2 character state abbreviation, "93" as the 2 digit
data year, and "076" as the lot number.

4. The file will be created. The main screen will be re-displayed with the newly
created filename at the top. The input file is open and ready. See How To Enter
Header Information (pg. 22) section of this manual for instructions on entering
header information and certificate data into the new input file.

Opening an Existing Input File

The ACME input file is a file containing ICD codes. The file will be processed through
both ACME and TRANSAX. If an input file has just been created (using Creating a New
Input File, pg. 14), that is the file that will be open. If PC-ACME/ TRANSAX was exited
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with a file still open, that file will be open when PC-ACME/ TRANSAX is restarted. To
open a different input file, follow the instructions below:

1. From the main screen, Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Open Input File Function and
press {ENTER}.

3. A file selection window (see Figure 6) will be displayed.

4. The following fields will be displayed on the file selection window. The user will
have access to only the Pick List of Files, OK, and CANCEL fields.

Directory
(Pick List of Files)
(Pick List of Directories)
(Pick List of Drives)
Filter
File
OK
CANCEL

5. To select a file from the Pick List of Files for processing, do the following. NOTE:
If the Pick List is empty, it cannot be accessed. In this case, select a new drive or a
new directory.

A. Use the {TAB} key to put the cursor in the Pick List of Files.

B. Use the up and down arrow keys to highlight the desired filename. The list will
scroll up or down to display additional files.

C. Press {ENTER}. The highlighted file will be selected. The main menu and
Menu Bar will be re-displayed.

6. Once a valid file has been selected, the main screen with the Menu Bar will be re-
displayed, and the name of the selected file will be displayed at the top of the
screen. (Example:  At the top of Figure 6 is the filename of the selected file.)

7. The file is now open and ready for use.
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+)))))))))))))))))))))))))))))))))))))))))))))))))),
*MICAR:  RESULTING ACME INPUT            PAGE: 1 *$*
*                                                *$*
*STATE NAME:  C:\MICAR\TEST1.MRJ                 *$*
*STATE CODE:  99                                 *$*
*                                                *$*
*                ACME ACME INT                   *$*
*ST  RA  CERT_#   REJ  UC  REJ   PI  MULT CAUSE  *$*
*99   6  000004     3                )960 8781 42*$*
*                                                *$*
*99   6  000015     3                5579 5570/79*$*
*                                                *$*
*99   6  000021     3                7997        *$*
*                                                *$*
*99   6  000055     3                5939/5789/79*$*
*                                                *$*
*99   6  000056     3                5990*7997   *$*
*                                                *$*
*                                                * *
.))))))))))))- Press ESC to close window.)))))))))2)-

1 of appx. 1010 10:30a

Figure 6:  The MICAR rejects file.

VIEWING MICAR REJECTS

Before MICAR rejects can be viewed, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

It is recommended that the MICAR rejects file be viewed and/or printed before any editing
is performed. It can be viewed and printed by following the directions below:

1. From the main screen, press {ALT-P} to select the Print/Reports Menu Option.

2. Use the up and down arrow keys to highlight the Show/Print Micar Rejects
Function and press {ENTER}.

3. A progress bar will be displayed while the file is being formatted for viewing.
When the formatting is finished, press {ENTER}.

4. A report window (see Figure 6) will be displayed.



PC-ACME/TRANSAX National Center for Health Statistics

Page 18 User's Guide

5. Use the {PgUp},{PgDn}, left and right arrow keys to scroll through the report. To
exit the report press the {ESC} key.

6. A window will be displayed, asking if the user wishes to print the report.

A. To print the report, press {Y}. A print in progress window will be displayed. If
ACME/TRANSAX is unable to print the report, an error message will be
displayed.

B. To abort the printing, press {N}.

7. The main screen will be re-displayed.
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EDIT REJECTED RECORDS

644444444444444444444444444444444444444444444444444444444444444444444447
5 Certificate 999999                                          1 of 37  5
5 3320/4409                                                            5
5                                                                      5
5     1     2     3     4     5     6     7     8                      5
5  644444L44444L44444L44444L44444L44444L44444L444447                    5
5Ia53320 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 b54409 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 c5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 d5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 e5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5II5     *     *     *     *     *     *     *     5                   5
5  944444N44444N44444N44444N44444N44444N44444N444448 State Specific Data5
5   Place Injury    Reject    UC       ACME Reject 1  Accounts         5
944444444444444444444444444444444444444444444444444444444444444444444448

   PgDn-Next record   PgUp-Previous record  Alt-F9-Save   F1-Help         

Figure 7:  The Edit Rejected Records screen.

EDITING MICAR REJECTS

Before MICAR rejects can be edited, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

Note: Some files may not have MICAR rejects to edit.

If a selected input file (see Opening An Input File, pg. 15) has any MICAR rejects, those
rejects will need to be edited before continuing in ACME. The steps for editing MICAR
rejects are given below:

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Correct MICAR Rejects Function
and press {ENTER}. If there are no MICAR rejects, this Function cannot be
accessed.
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3. A progress bar (see Figure 4) will be displayed showing what percentage of the
rejected records have been loaded.

4. When all the rejects have been loaded, the Edit Rejected Records screen (see
Figure 7) will be displayed.

5. Table 3 below lists the keys used on the Edit Rejected Records screen and their
functions.

6. Use the keys described in Table 3 to go through the rejected records and make
corrections. Specific instructions for correcting MICAR reject records are given in
APPENDIX E, pg. 53.

Table 3:  Editor Keys
Keys                      Function 

{ALT-F9} Save records and exit.

{ALT-D} Delete record.

{ALT-T} Transpose cells.

{CTRL-BACKSPACE} Delete line.

{CTRL-D} Delete cell.

{CTRL-END} Move cursor to Part II.

{CTRL-ENTER} Insert line.

{CTRL-HOME} Move cursor to first cell.

{CTRL-PgDn} Display last record in file.

{CTRL-PgUp} Display first record in file.

{CTRL-W} Clear cell.

{CTRL-Z} Save records and exit.

{ENTER} Move cursor to next cell.

{ESC} Exit without saving changes.

{F1} Display Help window.

{F5} Search for certificate #.
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{F9} Search for a specific certificate number.

{PgDn} Display next record. Add record if used
on the last record in the file

{PgUp} Display previous record.

{SHIFT-TAB} Move cursor to previous cell.

{TAB} Move cursor to next cell.

{ } Move cursor to the previous row.

{ } Move cursor to the next row.

7. When the corrections are finished, press {ALT-F9} or {CTRL-Z} to save the
changes. A message window will be displayed asking to confirm that all of the
records have been edited.

A. To merge the corrected records with the ACME input file, press {Y}. A
progress bar (see Figure 4) will be displayed showing what percentage of
records have been saved.

WARNING:  If the user presses {Y} to merge the edited records with the input
file, the user will not be able to use this function to re-edit MICAR rejects. Any
further corrections to the MICAR rejects will have to be made using the Editing
ACME input records Function (see EDITING AN ACME INPUT FILE, pg.
22).

B. To exit the Correct MICAR Rejects Function without merging the rejects, press
{N}.

9. When all the records have been saved, the main screen will be re-displayed.



PC-ACME/TRANSAX National Center for Health Statistics

Page 22 User's Guide

EDITING AN ACME INPUT FILE

Before an ACME input file can be edited, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

Some input files will need to be edited. This includes making changes to certificates in the
file as well as adding new certificates to a file. Use the instructions below to access the
Edit ACME Input File Function. If the file is new, the header information (How To Enter
Header Information) will need to be entered. Adding new certificates (How To Add
Certificates) and editing existing certificates (How To Edit ACME Certificates) also
have their own headings in this section.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit ACME Input File Function
and press {ENTER}. A file must be open to use this Function.

3. If the file is a new file (created using the instructions in Creating a New Input
File, pg. 14), a window will be displayed for the header information (see How to
Enter Header Information below). Otherwise a certificate screen (see Figure 9)
will be displayed and new certificates can be added (see How To Add ACME
Certificates, pg. 24) or edited (see How To Edit ACME Certificates, pg. 25).

How To Enter Header Information

Before header information can be edited, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

If a new file has been created, header information will need to be entered. This
information is constant data that will be duplicated for each record in the file. Follow the
instructions below to enter the header information.

1. A window will be displayed (see Figure 8).
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+))))))))))))))))))))))))))))))))))))))))))))))))))))))),
*               Header Information Window               *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))1
*                                                       *
* Shipment number:                                      *
*                                                       *
* Lot number.....:                                      *
*                                                       *
* Data year......:                                      *
*                                                       *
* State code.....:                                      *
*                                                       *
* Coder status...:                                      *
*                                                       *
*   Enter header information.  Press Esc to cancel      *
*                                                       *
.)))))))))))))))))))))))))))))))))))))))))))))))))))))))-

Figure 8:  A screen for entering header information.

2. The following fields will be in the window. The header information will be the
same for each record in the file. Fill in the appropriate header information as
follows:

Shipment - A 2-digit number from 01-15 commonly used to
indicate the receipt month or processing month.

Lot # - A 3-digit number from 000-999.  Some states will use
"book number."

Data Year - The last digit for the year of the death certificate
(Example:  1991 = 1, 1997 = 7).

State Code - A number identifying the state from which the death
certificate originates. (The states codes are listed in
APPENDIX A, pg. 46.)

Coder Status - A number from 0-9 used to identify the status of the
coder; can also be used to identify individual coders.

Example:  Codes for a batch of certificates being processed for data year 1987,
from the State of Alaska, with lot number 303, shipment 02, and coder status is
the production coder would have the following entries:  Shipment 02, Lot #
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303, Data Year 7, State Code 02, Coder Status 1.

3. After the header information has been entered, the Edit ACME Input screen
(Figure 9) will be displayed. See How to Add Certificates for instructions on
adding certificates to a file.

WARNING: If no certificates are saved (using either {CTRL-Z} or {ALT-F9}), the
header information will be lost.

How To Add Certificates

Before certificates can be added to an ACME input file, the following actions must have
already been performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

The Certificate Information Screen must be displayed (see EDITING AN ACME
INPUT FILE, pg. 22).

The maximum number of certificates that can be entered is determined by the amount of
free space on the hard drive. An estimate of the number of certificates that can be added is
given when ACME is first started.

1. The Edit ACME Input File screen (Figure 9) will be displayed. If there is a
different screen displayed, contact the System Manager for instructions.

2. Use the {CTRL-PgDn} key to move to the last record in the file. Press {PgDn}.

3. A message window will appear asking if the user wishes to add a new record.

A. To add a new record, press {Y}.

B. To exit the add records function, press {N}. This will re-display the Edit
ACME Input File screen (see Figure 9).
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EDIT ACME INPUT FILE

644444444444444444444444444444444444444444444444444444444444444444444447
5 Certificate 999999                                          1 of 37  5
5 3320/4409                                                            5
5                                                                      5
5     1     2     3     4     5     6     7     8                      5
5  644444L44444L44444L44444L44444L44444L44444L444447                    5
5Ia53320 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 b54409 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 c5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 d5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 e5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5II5     *     *     *     *     *     *     *     5                   5
5  944444N44444N44444N44444N44444N44444N44444N444448 State Specific Data5
5   Place Injury    Reject    UC       ACME Reject    Accounts         5
944444444444444444444444444444444444444444444444444444444444444444444448

   PgDn-Next record   PgUp-Previous record  Alt-F9-Save   F1-Help         

Figure 9:  The Edit ACME Input File screen.

4. If a new record is created, a new certificate number will be generated (this number
can be changed only when the certificate is first created. The certificate number
cannot be changed if the cursor is moved beyond the Certificate field). An empty
Edit ACME Input File screen (see Figure 9) will be displayed.

5. Enter the data as you would for the MICAR rejects editor, using the same keys
described in Table 3. NOTE: This is the only place where State Specific Data can
be changed.

6. When finished, press {ALT-F9} or {CTRL-Z} to save the data. A progress bar (see
Figure 4) will be displayed showing what percentage of the added certificates have
been saved.

7. When all the records have been saved, the main screen will be re-displayed.

How To Edit ACME Certificates

Before certificates can be edited, the following actions must have already been performed:
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Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

The Certificate Information Screen must be displayed (see EDITING AN ACME
INPUT FILE, pg. 22).

1. Table 4 below lists the keys used on the Edit ACME Input File screen and their
functions.

2. Use the keys described in Table 4 to go through the records and make corrections.

Table 4:  Edit ACME Input File Keys
Keys                      Function 

{ALT-F9} Save records and exit.

{ALT-D} Delete record.

{ALT-T} Transpose cells.

{CTRL-BACKSPACE} Delete line.

{CTRL-D} Delete cell.

{CTRL-END} Move cursor to Part II.

{CTRL-ENTER} Insert line.

{CTRL-HOME} Move cursor to first cell.

{CTRL-PgDn} Display last record in file.

{CTRL-PgUp} Display first record in file.

{CTRL-W} Clear cell.

{CTRL-Z} Save records and exit.

{ENTER} Move cursor to next cell.

{ESC} Exit without saving changes.

{F1} Display Help window.

{F5} Search for certificate #.
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{PgDn} Display next record. Add record if used
on the last record in the file

{PgUp} Display previous record.

{SHIFT-TAB} Move cursor to previous cell.

{TAB} Move cursor to next cell.

{ } Move cursor to the previous row.

{ } Move cursor to the next row.

3. Use the keys in Table 4 to edit the ACME input file.

4. When the corrections are finished, press {ALT-F9} or {CTRL-Z} to save the
changes. A progress bar will be displayed showing what percentage of the
certificates have been saved.

5. When all the records have been saved, the main screen will be re-displayed.
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64444444444444444444444444444444444444444444444444444444444444447
5              Enter sequence check parameters                  5
K)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))M
5                                                               5
5 Beginning certificate number: 112602                          5
5 Ending certificate number...: 115400                          5
5                                                               5
944444444444444444444I  Press Esc to cancel G444444444444444444448

Figure 10:  A sequence check window.

RUNNING A SEQUENCE CHECK

Before a sequence check can be done, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19).

After an input file has been selected and any MICAR rejects edited, the user should run a
sequence check to ensure that all of the certificates are present in the file. Note that the
sequence check assumes that all of the certificates in the file are in order by certificate
number.

1. From the main screen, press {ALT-C} to select the Print/Reports Menu Option.

2. Use the up and down arrow keys to highlight the Sequence Check Function and
press {ENTER}.

3. A sequence check window (see Figure 10) will be displayed with the starting and
ending certificate numbers in the file. Check the certificate numbers to be sure they
are correct.

4. To change the starting and ending certificate numbers, do the following. NOTE:
Moving past the last field will begin the sequence check.

A. Highlight either the beginning or ending certificate number (whichever one
needs to be changed) with the {TAB} or {SHIFT-TAB} keys.
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+))))))))))))))))))))))))))))))))))))))))))))))))))0),
* CHECKLIST FOR SHIPMENT C:\ACME\DATA\TEST1.DBF    * *
*                                                  *$*
*Beginning Certificate Number:   112602            *"*
*Ending Certificate Number:      115400            *"*
*Total Expected Records:         2799              *"*
*                                                  *"*
*                                                  *"*
*                                                  *"*
*112603              MISSING                       *"*
*                                                  *"*
*112626 - 112627     MISSING                       *"*
*                                                  *"*
*112630 - 112631     MISSING                       *"*
*                                                  * *
.))))))))))))))-  Press ESC to continue .)))))))))))2)-

Figure 11:  An ACME sequence check report.

B. Type in the new certificate number.

5. To begin the sequence check, press {ENTER} until a progress bar is displayed.

6. A progress bar (see Figure 4) will be displayed showing the percentage of the
sequence check that has been completed.

7. When the sequence check is finished, a message will be displayed. Press
{ENTER}.

8. A report window (see Figure 11) will be displayed showing the results of the
sequence check. Use the {PgUp} and {PgDn} keys to scroll through the report. To
exit the report press the {ESC} key.

9. A red window will be displayed, asking if the user wishes to print the report.

A. To print out the report, press {Y}. If PC-ACME/TRANSAX is unable to print
the report, an error message will be displayed. Press {ENTER} to return to the
main screen.

B. To cancel the print request and re-display the main screen, press {N}.
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PROCESSING AN ACME FILE

Before processing can be done, the following actions must have already been performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19).

1. From the main screen, press {ALT-R} to select the Run Menu Option.

2. Use the up and down arrow keys to highlight the Process ACME Function and
press {ENTER}.

3. A red message window will be displayed saying that the ACME tables are being
loaded into memory.

4. After the tables are loaded, a progress bar (see Figure 4) will be displayed showing
the number of records that have been processed. Processing can be halted by
pressing the {ESC} key.

5. When processing is finished, a message window will be displayed.

6. Press {ENTER} to return to the main screen.
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+))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))),
*             PC-ACME Statistics for TEST1.DBF                *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))0)1
*                                                           * *
*              STATISTICAL SUMMARY FOR ACME CYCLE           *$*
*                                                           *$*
*ACME RUN ON.....: 08/08/95                                 *"*
*INPUT FILE NAME.: TEST1.DBF                                *"*
*OUTPUT FILE NAME: TEST1.DBF                                *"*
*                           NUMBER                          *"*
*                         OF RECORDS           PERCENT      *"*
*                                                           *"*
*TOTAL RECORDS               2473              100.00%      *"*
*                                                           *"*
*REJECTED RECORDS               0                0.00%      *"*
*  INVALID M/C DATA OR FORMAT   0                0.00%      *"*
*  REJECT 5                     0                0.00%      *"*
*  REJECT 9                     0                0.00%      * *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))2)1
* $$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$"""  *
.)))))))))))))))))))))- Press Esc to quit.)))))))))))))))))))))-

Figure 12:  The ACME Stats window.

VIEWING ACME STATS

Before ACME stats can be viewed, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19).

The file must be processed (PROCESSING AN ACME FILE, pg. 30).

After the ACME input file has been processed, the statistics of the processing should be
viewed to check for any discrepancies.

1. From the main screen, press {ALT-V} to select the View-Info Menu Option.

2. Use the up and down arrow keys to highlight the ACME Stats Function and press
{ENTER}.
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3. The statistics report (see Figure 12) will be displayed. Use the {PgUp} and
{PgDn} keys to scroll up and down through the report. Use the right and left arrow
keys to move the window horizontally through the report.

4. After viewing the report, press the {ESC} key.

5. A red window will be displayed, asking if the user wishes to print out the report.

A. To print out the report, press {Y}. The main screen will be re-displayed. If PC-
ACME/TRANSAX is unable to print the report, an error message will be
displayed.

B. To cancel the print request, press {N}. The main screen will be re-displayed.
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EDIT REJECTED RECORDS

644444444444444444444444444444444444444444444444444444444444444444444447
5 Certificate 999999                                          1 of 37  5
5 3320/4409                                                            5
5                                                                      5
5     1     2     3     4     5     6     7     8                      5
5  644444L44444L44444L44444L44444L44444L44444L444447                    5
5Ia53320 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 b54409 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 c5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 d5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 e5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5II5     *     *     *     *     *     *     *     5                   5
5  944444N44444N44444N44444N44444N44444N44444N444448 State Specific Data5
5   Place Injury    Reject    UC       ACME Reject 2  Accounts         5
944444444444444444444444444444444444444444444444444444444444444444444448

   PgDn-Next record   PgUp-Previous record  Alt-F9-Save   F1-Help         

Figure 13:  The Edit Rejected Records screen.

EDITING ACME REJECTS

Before ACME rejects can be edited, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19).

The file must be processed (PROCESSING AN ACME FILE, pg. 30).

ACME is designed to reject records with invalid format and/or codes, intentional reject
codes 5 and 9, and records that can be assigned only a conditional underlying cause of
death. These rejects will need to be edited and re-processed (see PROCESSING AN
ACME FILE, pg. 30). The screens displayed and the keys used for Editing ACME rejects
are the same used for editing MICAR rejects (see EDITING MICAR REJECTS, pg.
19). Table 5 provides a list of keys and their functions. Reject messages generated by
ACME are also readily available for review (see step 7).
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1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Correct ACME Reject Records
Function and press {ENTER}.

3. A progress bar (see Figure 4) will be displayed showing what percentage of the
rejected records have been loaded.

4. When all the rejects have been loaded, the Edit Rejected Records screen (see
Figure 13) will be displayed.

5. Table 5 lists the keys used on the Edit Rejected Records screen and their functions.

Table 5:  ACME Reject Editor Keys
Keys                      Function 

{ALT-F9} Save records and exit.

{ALT-D} Delete record.

{ALT-M} Display error messages for record

{ALT-T} Transpose cells.

{CTRL-BACKSPACE} Delete line.

{CTRL-D} Delete cell.

{CTRL-END} Move cursor to Part II.

{CTRL-ENTER} Insert line.

{CTRL-HOME} Move cursor to first cell.

{CTRL-PgDn} Display last record in file.

{CTRL-PgUp} Display first record in file.

{CTRL-W} Clear cell.

{CTRL-Z} Save records and exit.

{ENTER} Move cursor to next cell.

{ESC} Exit without saving changes.

{F1} Display Help window.
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{F5} Search for certificate #.

{PgDn} Display next record. Add record if used
on the last record in the file

{PgUp} Display previous record.

{SHIFT-TAB} Move cursor to previous cell.

{TAB} Move cursor to next cell.

{ } Move cursor to the previous row.

{ } Move cursor to the next row.

6. Use the keys described in Table 5 to go through the rejected records and make
corrections.

7. To view the reject messages (as in Figure 14), press {ALT-M}. These messages
tell why the record was rejected. Specific instructions for correcting the ACME
rejects are given in APPENDIX E, pg. 56.
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EDIT REJECTED RECORDS

6+)))))))))))))))))))))))))))))))))))))))))))))))))))))))))),44444444447
5*             Messages generated for this record            *          5
5/))))))))))))))))))))))))))))))))))))))))))))))))))))))))))1           5
5* 21003383012001       201                                  *          5
5* 21003383012001       202WRONG LENGTH CODE                 *          5
5/))))))))))))))))))))))))))))))))))))))))))))))))))))))))))1           5
5*  $$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$"""""""""""""""""  *          5
5.)))))))))))- Press ESC to close message window.))))))))))))-           5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 b54409 *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 c5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 d5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5 e5     *     *     *     *     *     *     *     5                   5
5  K)))))3)))))3)))))3)))))3)))))3)))))3)))))3)))))M                    5
5II5     *     *     *     *     *     *     *     5                   5
5  944444N44444N44444N44444N44444N44444N44444N444448 State Specific Data5
5   Place Injury    Reject    UC       ACME Reject 1  Accounts         5
944444444444444444444444444444444444444444444444444444444444444444444448

PgDn-Next record    PgUp-Previous record    Alt-F9-Save   F1-Help   8 48am

Figure 14:  The Edit Rejected Records screen with messages displayed.

8. To save the corrections, press {ALT-F9} or {CTRL-Z}. The user can save changes
and then go back to make more corrections at a later time so long as the file has not
been re-processed.

9. A progress bar (see Figure 4) will be displayed showing what percentage of
records have been saved.

10. When all the records have been saved, the main screen and Menu Bar will be re-
displayed.

11. The user should now follow the instructions in PROCESSING AN ACME FILE
(pg. 30) to re-process the corrected batch. NOTE: If all of the rejected records are
deleted, follow the instructions under PROCESSING A TRANSAX FILE, pg. 38.
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PROCESSING ACME REJECTS

Before ACME rejects can be processed, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19).

The file must be processed (PROCESSING AN ACME FILE, pg. 30).

ACME rejects need to be edited (EDITING ACME REJECTS, pg. 33).

1. From the main screen, press {ALT-R} to select the Run Menu Option.

2. Use the up and down arrow keys to highlight the Process ACME Rejects Function
and press {ENTER}.

3. A red message window will be displayed saying that the ACME tables are being
loaded into memory.

4. After the tables are loaded, a progress bar (see Figure 4) will be displayed showing
the number of records that have been processed. Processing can be halted by
pressing the {ESC} key.

5. When processing is finished, a message window will be displayed.

6. Press {ENTER} to return to the main screen.
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PROCESSING A TRANSAX FILE

Before TRANSAX processing can be done, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19).

The file must be processed (PROCESSING AN ACME FILE, pg. 30).

Any ACME rejects need to be edited (EDITING ACME REJECTS, pg. 33) and
processed (PROCESSING ACME REJECTS, pg. 37).

ACME processing produces a TRANSAX input file that will need to be processed using
TRANSAX. Remember, all of the ACME rejects must be edited before TRANSAX
processing can be performed. The steps in this are very similar to those for
PROCESSING AN ACME FILE, except no rejects are generated.

1. From the main screen, press {ALT-R} to select the Run Menu Option.

2. Use the up and down arrow keys to highlight the Run TRANSAX Function and
press {ENTER}.

3. A red message window will be displayed saying that the TRANSAX tables are
being loaded into memory.

4. After the tables are loaded, a progress bar (see Figure 4) will be displayed showing
the number of records that have been processed. Processing can be halted by
pressing the {ESC} key.

5. When processing is finished, a message window will be displayed.

6. Press {ENTER} to return to the main screen.
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+))))))))))))))))))))))))))))))))))))))))))))))))))))))))))))),
*              TRANSAX Statistics for TEST1.DBF               *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))0)1
*            STATISTICAL SUMMARY FOR TRANSAX CYCLE          * *
*                                                           *$*
*Trax ran on.....: 08/08/96                                 *$*
*Input file name.: TEST1.DBF                                *$*
*Output file name: TEST1.DBF                                *$*
*                                                           *$*
*-----------------------------------------------------------*"*
*                                                           *"*
*        SUMMARY TABLE - AXIS TRANSLATION PROGRAM           *"*
*        ----------------------------------------           *"*
*  2506  TOTAL RECORDS READ                                 *"*
*                                                           *"*
*  2506  TOTAL RECORDS THROUGH AXIS CONVERSION PHASE        *"*
*      194  TOTAL RECORDS WITH ONE OR MORE CONVERSIONS      * *
/)))))))))))))))))))))))))))))))))))))))))))))))))))))))))))2)1
* $$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$""""""""" *
.))))))))))))))))))))- Press Esc to quit.))))))))))))))))))))))-

Figure 15:  The TRANSAX Log.

VIEWING TRANSAX STATS

Before TRANSAX stats can be viewed, the following actions must have already been
performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

MICAR rejects must be edited (EDITING MICAR REJECTS, pg. 19) and processed
(PROCESSING AN ACME FILE, pg. 30).

Any ACME rejects need to be edited (EDITING ACME REJECTS, pg. 33) and
processed (PROCESSING ACME REJECTS, pg. 37).

TRANSAX processing must be performed (PROCESSING A TRANSAX FILE, pg.
38).

The TRANSAX statistics can be viewed in the same manner as for VIEWING ACME
STATS. The statistics will also be displayed in the same format.



PC-ACME/TRANSAX National Center for Health Statistics

Page 40 User's Guide

1. From the main screen, press {ALT-V} to select the View-Info Menu Option.

2. Use the up and down arrow keys to highlight the TRANSAX Stats Function and
press {ENTER}.

3. The TRANSAX stats (see Figure 15) will be displayed. Use the {PgUp} and
{PgDn} keys to scroll up and down through the report. Use the right and left arrow
keys to move the window horizontally through the report.

4. When the user finishes viewing the report, press the {ESC} key.

5. A window will be displayed, asking if the user wishes to print out the report.

A. To print out the report, press {Y}. If PC-ACME/TRANSAX is unable to print
the report, an error message will be displayed. The main screen will be re-
displayed when the printing is finished.

B. Press {N} to cancel the print request. The main screen will be re-displayed.
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CREATING BACKUPS

Before backups can be made, the following actions must have already been performed:

Opening a file (Creating a New Input File, pg. 14, or Opening an Existing Input File,
pg. 15).

After processing the data files, a backup should be made of the files that have been used
and generated by PC-ACME/TRANSAX. Backups for several runs of PC-ACME/
TRANSAX can be stored in the same backup file. All of the data and the associated files
(including the TRANSAX output file) will be backed up. It is also recommended to take a
backup at the end of each day. To create these backups, follow the directions below.

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Backup Files Function and press
{ENTER}.

3. A file selection window will be displayed (see Figure 6). Refer to Opening An
Input File (pg. 15) instructions on how to use the file selection window.

4. Choose a filename (with a .ABK extension) to put the backup files in from the Pick
List of Files. If there are no backup files in the Pick List of Files, use the {TAB}
key to highlight the FILE field and type in a new backup filename with the .ABK
extension  (Example:  BACKUP1.ABK). Press {ENTER}.

5. A progress bar (see Figure 4) will be displayed showing what percentage of the
files have been backed up. If a file already exists in the backup file (as when the
user makes two backups of the same data), a warning message will be displayed.

A. To overwrite the old backup, type {Y} or use the {TAB} key to highlight the
YES field and press {ENTER}. WARNING: The old backup will be destroyed.

B. To prevent overwriting the old backup, type {N} or use the {TAB} key to
highlight the NO field and press {ENTER}. The backup will continue without
overwriting the old backup of the indicated file.

C. To cancel the backup process, type {C} or use the {TAB} key to highlight the
CANCEL field and press {ENTER}.
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6. When the backup is completed, a message window will be displayed. Press
{ENTER}.

7. The main screen and Menu Bar will be re-displayed.



National Center for Health Statistics PC-ACME/TRANSAX

User's Guide Page 43

RESTORING FROM BACKUPS

On occasion, it will be necessary to restore a data file from a backup (see CREATING
BACKUPS, pg. 41). PC-ACME/TRANSAX's Restore function will recover data from a
backup file. It is strongly recommended that after each file is processed, and at the end of
each day, that the Backup Function be used.

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Restore From Backup Function
and press {ENTER}.

3. A file selection window will be displayed (see Figure 4). Refer to Opening An
Input File, pg. 15, for instructions on how to use the file selection window.

4. Choose the backup file (a file with a .ABK extension) to restore from. The
available files will be listed in the Pick List of Files. Once the desired file is
highlighted, press {ENTER}.

5. If a file with the same name as the one being restored already exists in the
<ACME/DATA> directory, a message window will be displayed.

A. To overwrite the existing file, press {Y}.

B. To abort the restore, press {N}.

6. A progress bar (see Figure 4) will be displayed showing what percentage of the
file has been restored.

7. When the restore is completed, a message window will be displayed. Press
{ENTER}.

8. The main screen and Menu Bar will be re-displayed.
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CLOSING A FILE

After the user is finished with a file, the file can be closed and a new one opened.

1. From the main screen, Press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Close Input File Function and
press {ENTER}.

3. The currently open file will be closed. The main screen will be redisplayed without
a filename at the top.
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ENDING A SESSION WITH PC-ACME/TRANSAX

When the user is finished with a batch of data and is ready to start a new batch, simply
select a new input file (as described in Opening An Input File, pg. 15,) and repeat the
process described in this manual.

To exit the PC-ACME/TRANSAX software, the main screen must be displayed. Press
{ALT-X}. A message window will be displayed. Type {Y} to exit PC-ACME/TRANSAX
and return to DOS. Type {N} to re-display the main screen.



PC-ACME/TRANSAX National Center for Health Statistics

Page 46 User's Guide

APPENDIX A - NCHS STATE CODES

 
Code State Abbrev. Code State Abbrev.
01 Alabama AL 28 Nebraska NE
02 Alaska AK 29 Nevada NV
03 Arizona AZ 30 New Hampshire NH
04 Arkansas AR 31 New Jersey NJ
05 California CA 32 New Mexico NM
06 Colorado CO 33 New York NY
07 Connecticut CT 34 North Carolina NC
08 Delaware DE 35 North Dakota ND
09 Dist. Columbia DC 36 Ohio OH
10 Florida FL 37 Oklahoma OK
11 Georgia GA 38 Oregon OR
12 Hawaii HI 39 Pennsylvania PA
13 Idaho ID 40 Rhode Island RI
14 Illinois IL 41 South Carolina SC
15 Indiana IN 42 South Dakota SD
16 Iowa IA 43 Tennessee TN
17 Kansas KS 44 Texas TX
18 Kentucky KY 45 Utah UT
19 Louisiana LA 46 Vermont VT
20 Maine ME 47 Virginia VA
21 Maryland MD 48 Washington WA
22 Massachusetts MA 49 West Virginia WV
23 Michigan MI 50 Wisconsin WI
24 Minnesota MN 51 Wyoming WY
25 Mississippi MS 52 Puerto Rico PR
26 Missouri MO 53 Virgin Islands VI
27 Montana MT 54 Guam GU

55 New York City YC*

* Code 55 is used for occurrence data only. When coding residence data on the demographic
file, code 33 (New York) must be used.
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APPENDIX B - MENU LISTING

Below is a full listing of all the Menu Options and their attendant Functions. Those
Functions with hot keys have the hot key listed as well.

TABLE 1:        
Key Combination               Menu Option Accessed      

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-R} Run Menu Option

{ALT-P} Print/Reports Menu Option

{ALT-V} View-Info Menu Option

{ALT-H} Help Menu Option
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MENU LISTINGS

File
{SHIFT-F8} Import ACME Input Files
{F2} Open Input File
{ALT-F2} Create New Input File
{ALT-F4} Close Input File
{SHIFT-F7} Send Files To NCHS
{ALT-F7} Backup All Files
{ALT-F8} Restore From Backup
{ALT-D} Set Data Path
{ALT-T} Set Table Path

Export TRANSAX Input File to ASCII
Export TRANSAX Output File to ASCII

{ALT-X} Exit

Edit
{ALT-M} Correct MICAR Rejects
{F9} Correct ACME Reject Records
{ALT-I} Edit ACME Input File

Run
{F6} Process ACME
{F7} Process ACME Rejects
{F8} Run TRANSAX

Print/Reports
{ALT-F3} Sequence Check

Show/Print Micar Rejects

View-info
ACME Stats
TRANSAX Stats
Browse Input File
Configuration

Help
{F1} Display Help Text
{ALT-F1} About ACME
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APPENDIX C - DICTIONARY OF TERMS USED

Since not everyone will be familiar with the terms used in these instructions, here is a brief
glossary of some of the words.

Certificate File - A file containing medical data from a batch of death certificates.

Directory - A specific grouping of files on a disk. Also referred to as a
subdirectory. The directory that will be used most with
PC-ACME/TRANSAX will be the <ACME> directory, unless the
DESTINATION PATH was changed during installation (see
Installation Instructions in the PC-ACME/TRANSAX System
Manager's Manual).

DOS - A Disk Operating System. DOS will be used only during the initial
installation of the PC-ACME/TRANSAX files and when starting
PC-ACME/TRANSAX (see STARTING PC-ACME/TRANSAX,
pg. 4, 10).

Export - The steps used to copy a certificate file(s) from the
<ACME/DATA> directory to another directory or disk.

Extension - A 3-letter identifier at the end of a filename that identifies what type
of file it is. For example:  .EXE is an executable file, .AIN is a
PC-ACME input file, and so forth.

Filename - The name of a file on a disk. Example:  ACME.EXE is made up of
the filename ACME and extension .EXE.

Import - The steps used to copy a certificate file into the <ACME/DATA>
directory.

Path - A combination of a drive, directory, and/or subdirectories.
Example: C:\ACME\TABLES.

Pick List - A list of items that can be selected (picked) by using the up and
down arrow keys to highlight the desired item and then pressing
{ENTER}.
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Subdirectory - See Directory above.
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APPENDIX D - CONVENTIONS USED IN THIS MANUAL

As a rule, any commands that need to be entered while the user is running
PC-ACME/TRANSAX will be given in the following format:

1. All of the actual typing and keys that need to be pressed will be given in all-caps
(Example:  type DIR and press {ENTER} to get a list of the files in the current
directory).

2. Any information that the user needs to provide, such as filenames, will be
requested in brackets (Example:  TYPE [filename.ext] means that the user needs to
type in the filename and its extension, like so:  TYPE AA1991.AIN, without the
brackets.)

3. When the word "press" appears in front of a word in all-caps, the user needs to
press and release a particular key (Example:  press and release {ESC} means press
the ESC key and then release it). Also, the names of all keys will be given in braces
{}.

4. Whenever two keys are named with a hyphen ( - ) connecting them, both keys are
to be pressed at the same time and then released to perform the listed function.
(Example:  {CTRL-ENTER} = press and hold the {CTRL} and press the
{ENTER} key. Then release them both.)

5. At times, references will be made to Menu Options or Functions of
PC-ACME/TRANSAX. The following standards will be used in these cases:

A. Any word on the Menu Bar (the colored bar across the top of the screen) will
be called a Menu Option. When the Menu Option is named in the text, it will
be in bold letters (Example:  To access the File Menu Option, press {ALT-F}).

B. Any option in a submenu (one of the pull down menus from the menu bar) will
be called a menu Function or just Function (Example:  To use the Input File
Function, press {ALT-F} and use the arrow keys to highlight the File Menu
Option. The File submenu will be displayed. Use the arrow keys again to
highlight the Input File Function and press {Enter}).

6. All directory names will be marked by greater than and less than symbols
(Example:  The directory containing the PC-ACME/TRANSAX programs is the
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<ACME> directory).

7. ** IMPORTANT **  Throughout this manual, the directory containing the
PC-ACME/TRANSAX files will be called the <ACME> directory. The directory
containing the PC-ACME/TRANSAX files can be changed during installation. See
the Installation Instructions in the PC-ACME/TRANSAX System Manager's
Manual for details on how to change the directory containing the PC-
ACME/TRANSAX files.
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APPENDIX E - MAKING CHANGES TO MICAR REJECTS

MICAR REJECT PROCESSING

Files containing records rejected by the MICAR programs are generated in ACME input
file format. These records must be reviewed and coded in accordance with the NCHS
multiple cause coding instructions given in Part 2b and Part 2e of the Vital Statistics
Instruction Manual (VSIM) series. On most certificates, the reject record will have
tentative ICD-9 codes for multiple cause data and may have codes for the place of injury
and the intentional reject items.  However, these codes are only provisional. The data must
be reviewed carefully. Replace any incorrect data with correct multiple cause codes. 

1. Multiple Cause Codes:

A. Records with one or more terms that did not match the dictionary:
MICAR assigns ICD-9 code 7997 for all terms which did not match the
dictionary. These codes must be replaced by the correct ICD-9 code or deleted.
In addition, all other multiple cause codes must be verified for accuracy.

For example:
1. A 1 HEMORRHAGE

B 1 BACK INJURY
C 1 INTERCOSTAL SPACE STAB WOUND

Tentative ICD-9: )591/)591/7997*&8289

2. A 1 HEMORRHAGE
B 1 INTERCOSTAL SPACE STAB WOUND
C 1 BACK INJURY

Tentative ICD-9: 4590/7997/)591*&8289

In the first example, the MICAR system has enough information to make the
HEMORRHAGE traumatic. However, in the second example, the system did
not have enough information to convert the HEMORRHAGE to traumatic
because the term which was not in the dictionary is reported on line b. MICAR
rejects must be coded based upon a thorough knowledge of NCHS multiple
cause coding rules.
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B. Records with indications of surgery:

In many cases, MICAR will contain an extra ICD-9 code immediately
following the code for the external cause. Generally, this code must be deleted.
It is also important to remember to precede the appropriate code with an "&" as
required by multiple cause coding.

C. Records with medical misadventures and drug therapy:

In most cases, MICAR will NOT provide ICD-9 codes for records interpreted
as requiring a drug therapy code. The multiple cause coder must provide all the
codes for these records.

2. Place of Injury:
The place of injury code is copied from the MICAR input record. This code must
be verified and deleted or retained based upon multiple cause coding rules.

3. Intentional Reject:
This code appears to the right of the label "REJECT" on the reject editor screen.
MICAR may assign an intentional reject 1 - 5 on records with one or more
inconsistencies reported in the duration blocks or a 9 on records with more than
four "due to's". It is the responsibility of the multiple cause coder to correct the
MICAR code assignment when necessary.

4. Underlying Cause:
A manual underlying cause (UC) code should not be assigned to the MICAR
rejects. The corrected reject records will be combined with the records completely
processed by the MICAR system then processed by the full ACME program.
Additional rejects may occur if a record has an "ambivalent" causal relationship, an
intentional reject code 5 or 9, or invalid codes or format errors. If a manual UC is
assigned, the codes and format will be validated; records with invalid data will
reject. In addition, the manual UC will be compared with the ACME underlying
cause and the records will be rejected for review if the codes are different.

5. ACME Reject:
The ACME Reject is an action code supplied by the system. As a rule, this code
should not be changed during MICAR or ACME reject processing. When adding
records to an ACME input file, this item should be left blank. On records rejected
by MICAR, a '1' indicates that the record contains a term which is not in the
MICAR dictionary; a '3' indicates that MICAR has identified the record as having
conditions which cannot be handled automatically by the multiple cause rules
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application program. Action code '2' is assigned by the ACME processor. The
purpose of action code 2 is to cause the ACME program to execute the editing and
validation features but to skip the underlying cause selection portion of the
program logic. The manual underlying cause code is accepted as the final
underlying cause-of-death.
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APPENDIX F - ACME REJECT ERROR MESSAGES

1. The following error messages indicate a need to correct the multiple cause codes and/or
format, and to manually assign an underlying cause.

Format Error
TOO MANY LINES
TOO MANY *'S
TOO MANY CODES PER LINE

Code Error
INVALID DIGIT IN CODE
WRONG LENGTH CODE
INVALID CODE XXXX
INVALID CODE IN PARENTHESES

2. The following messages indicate a need to manually assign an underlying cause.

Cause Not Addressed in Tables
NO ENTRY IN TABLE C FOR CODE XXXX

Intentional Reject
REJECT CODE = 5 (inconsistent duration which ACME cannot resolve)
REJECT CODE = 9 (more than four due to's)

Invalid ACME Underlying Cause
XXXX IS INVALID UNDERLYING CAUSE
INVALID MANUAL UNDERLYING CAUSE = XXXX (applicable only to second pass
processing)

Other
CIRCULAR LINKAGE LOOP

3. Messages indicating a need to verify and possibly correct the ACME underlying cause
assignment.

Ambivalent Table Entries
CAN XXXX BE DUE TO YYYY MAYBE
XXXX DS YYYY MAYBE
XXXX SENDC YYYY MAYBE
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XXXX SENMC YYYY ZZZZ MAYBE
XXXX IDDC YYYY ZZZZ MAYBE
XXXX LMP YYYY MAYBE
XXXX SMP YYYY MAYBE
XXXX LDP YYYY MAYBE

ACME/Manual Discrepancy
MANUAL UNDERLYING CAUSE = XXXX
ACME UNDERLYING CAUSE = YYYY

In these cases, the ACME assignment is conditional. If in the review of the record the
conditional underlying cause is found to be correct, no correction need be made.

4. Messages which may accompany the above types but are informational in nature and give
the logic followed in assigning the underlying cause. Such messages require no action.
The following list is organized by selection/modification rule for sake of clarity.

Selection Rule
CAN XXXX BE DUE TO YYYY YES
CAN XXXX BE DUE TO YYYY NO
TUC = XXXX SELECTION RULE

Rule 3
XXXX DS YYYY
XXXX DSC YYYY ZZZZ

Rule 4
XXXX IS SENILITY
XXXX SENDC YYYY ZZZZ
XXXX SENMC YYYY ZZZZ

Rule 5
XXXX IS ILL-DEFINED
TUC IS ILL-DEFINED: RESELECT
XXXX IS TUC (765-766)
XXXX IS NON-ID FROM PART II
XXXX IS ID TUC FROM PART I
XXXX IS ID TUC FROM PART II
XXXX IS ID TUC
XXXX IDDC YYYY ZZZZ
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Rule 6
XXXX IS TRIVIAL
XXXX IS FROM PART II

Rule 7
XXXX LMP YYYY
XXXX LMC YYYY ZZZZ
XXXX LDP YYYY
XXXX LDC YYYY ZZZZ
CONFLICT IN LINKAGE

Rule 8
XXXX SMP YYYY
XXXX SMC YYYY ZZZZ
XXXX SDC YYYY ZZZZ
CONFLICT IN SPECIFICITY

Recode E-Codes
RECODE E-CODE XXXX

Priority to Ampersand
TUC IS MED-CARE: PREFER AMP XXXX
TUC IS N-CODE: PREFER AMP-E-CODE XXXX
TUC IS N-CODE EXCEPTION: RESELECT
TUC IS E-CODE EXCEPTION: PREFER AMP XXXX

Other
XXXX CONVERTED TO YYYY
MANUAL UC = XXXX ACME UC = XXXX
TUC = XXXX
IGNORE INCONSISTENT DURATION

Abbreviations

ACME UC ACME-assigned Underlying Cause code
AMP Ampersanded code
DS Direct Sequel
DSC Direct Sequel Combination
E-CODES External Cause of Injury and Poisoning Code
ID Ill-Defined condition
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IDDC Ill-Defined "Due To" Combination
LDC Linkage "Due To Position" Condition
LDP Linkage "Due To Position" Preference
LMC Linkage "With Mention Of" Combination
LMP Linkage "With Mention Of" Preference
MANUAL UC Manually assigned Underlying Cause code
MED-CARE Medical Care Code
N-CODES Nature of Injury and Poisoning Code
NON-ID Non-Ill-Defined condition
SDC Specificity "Due To Position" Combination
SENDC Senility "Due To" Combination
SENMC Senility with Mention of Combination
SMC Specificity "With Mention Of" Combination
SMP Specificity "With Mention Of" Preference
TUC Temporary Underlying Cause
TUC2 second Temporary Underlying Cause
XXXX code
YYYY code
ZZZZ code

Correction Instructions:

1. Obtain the certificate(s) and any available additional information.

2. For each record in the file, do one of the following:

A. Manually assign an underlying cause of death

B. Correct an erroneous conditional underlying cause assignment made by ACME

C. ACME is allowed to keep the conditional assignment made if the assignment is
correct. This is the default option and requires no action by the individual
processing the reject lists.

D. Modify multiple cause codes as necessary. 

4. The following table lists what corrective action should be taken with a given error
message.
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TABLE OF MESSAGES REQUIRING ACTION

Correct Check ACME
Multiple Manually Underlying Cause
Cause Codes Assign And Make Manual
And/Or Underlying Assignment If

Error Message Format Cause Incorrect

TOO MANY LINES x x x
TOO MANY *'S x x x
TOO MANY CODES PER LINE x x x
INVALID DIGIT IN CODE x x x
WRONG LENGTH CODE x x x
INVALID CODE XXXX x x x
INVALID CODE IN PARENTHESES x x x
NO ENTRY IN TABLE C FOR CODE XXXX x x
REJECT CODE = 5 x x
REJECT CODE = 9 x x
XXXX IS INVALID UNDERLYING CAUSE x x
INVALID MANUAL UNDERLYING CAUSE = XXXX x x

(second pass processing only)
CIRCULAR LINKAGE LOOP x x
CAN XXXX BE DUE TO YYYY MAYBE x
XXXX DS YYYY MAYBE x
XXXX SENDC YYYY MAYBE x
XXXX SENMC YYYY ZZZZ MAYBE x
XXXX IDDC YYYY ZZZZ MAYBE x
XXXX LMP YYYY MAYBE x
XXXX SMP YYYY MAYBE x
XXXX LDP YYYY MAYBE x
MANUAL UNDERLYING CAUSE = XXXX x
ACME UNDERLYING CAUSE = YYYY x
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